Developing Search Strategy for Systematic Review and Meta-Analysis

Annelissa Chin & Stephanie Ng
NUS Libraries

20 June 2019
The Medical Library Training Room, MD6 Level 5
Course Outline

1. About systematic review
2. Preparing an EndNote Library for Systematic Review
3. Defining A Focused Question
4. Identifying Sources to Search
5. Search Syntax
6. Subject Heading vs. Keyword search

7. Developing Search Strategy (with hands-on exercises)
   a. Pubmed
   b. The Cochrane Library
   c. Embase

8. Reporting the Search Process

9. Managing Search Results With EndNote
   ▪ Remove duplicates
   ▪ Export the Endnote Library to Excel
   ▪ Backup
About Systematic Review?

A systematic review attempts to collate all empirical evidence that fits pre-specified eligibility criteria in order to answer a specific research question. It uses explicit, systematic methods that are selected with a view to minimizing bias, thus providing more reliable findings from which conclusions can be drawn and decisions made (Antman 1992; Oxman 1993).

What is meta-analyses?
Many systematic reviews contain meta-analyses. Meta-analyses is the use of statistical methods to summarize the results of independent studies (Glass 1976). By combining information from all relevant studies, meta-analyses can provide more precise estimates of the effects of health care than those derived from the individual studies included within a review (see Chapter 9, Section 9.1.3).

Ref: Cochrane Handbook for Systematic Reviews of Interventions
Steps To Conduct A Systematic Review

- Formulate a focused question
- Write your review protocol
- Identify resources to search
- Develop your search strategy
- Run your search (PubMed, EMBASE, Cochrane, etc)
- Export citations to EndNote
- Delete duplicate
- Title abstract screening
- Full text screening
- Critical Appraisal
- Extract the data and synthesise the results
- Interpret your findings
- Publish and disseminate the results

LIBRARIANS PROVIDE GREAT HELP

RESEARCHER MUST WORK ON THIS
Before Doing A Systematic Review

Has a review been done before?

Search the systematic review databases:
  • Prospero http://www.crd.york.ac.uk/PROSPERO
  • Cochrane Reviews https://www.cochranelibrary.com/
  • PubMed
  • Embase

Write & register your review
  • Write your protocol
  • Refer to the PRISMA for systematic review protocols (PRISMA-P) for reporting standard for protocols http://www.prisma-statement.org/Extensions/Protocols.aspx
  • Register your research (e.g. Prospero or Cochrane)
PREP

Customise settings in Endnote for Systematic Review
Create A New EN Library

1. Search Windows > EndNote
2. Click on File > New
3. Enter a filename e.g. SysRev (.enl)
4. Select location to save the library (e.g. on your Desktop)
5. Click Save
Moving & Saving Your EN Library

Raw files

Where?

Back-up

How to move?

Compressed file
Customise Fields To Display Record #
My Groups Feature (To Organise)

- Group 1
- Group 2
- Group 3
Defining a Focused Clinical Question

PICO framework
## PICO

A useful tool/framework for asking focused clinical questions

<table>
<thead>
<tr>
<th>P</th>
<th>AND</th>
<th>I</th>
<th>C</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
<td>Patients</td>
<td>Problems</td>
<td>Interventions or exposures</td>
<td>Comparison</td>
</tr>
<tr>
<td>How would you describe a group of patients?</td>
<td>What do we want to do with them?</td>
<td>What is the main alternative being considered, if any?</td>
<td>What are you trying to accomplish, measure, improve, or affect?</td>
<td></td>
</tr>
<tr>
<td>What is the problem?</td>
<td>What are they exposed to?</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
You are a pediatrician working in an emergency ward. During your daily practice, you are frequently faced with nervous children who are fearful of pain caused needle-related procedures.

Now a new needle-free jet injection of lidocaine has been introduced into the market. “Just ask any child or parent who’s experienced the ‘soda pop thing’ before an IV start and you’ll hear them state that the needle “didn’t hurt at all.”

You ask if this is effective in minimising pain and distress associated with needle procedures compared to the other anaesthesia or sham treatment.
Framing The Question

Clinical Question: What is the efficacy of jet lidocaine for children who are fearful of pain caused by needle-related procedure?

<table>
<thead>
<tr>
<th>PICO Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATIENT (P)</td>
</tr>
<tr>
<td>INTERVENTION (I)</td>
</tr>
<tr>
<td>COMPARATOR (C)</td>
</tr>
<tr>
<td>OUTCOME (O)</td>
</tr>
<tr>
<td>STUDY DESIGN (S)</td>
</tr>
</tbody>
</table>
The Evidence Pyramid

• Describes a hierarchy, where systematic reviews are seen as the most reliable form of evidence.
• Help you to consider the quality and reliability of evidence

Source: http://www.nhsevidencetoolkit.net/what-is-evidence/
Exercise 1: Plan Your Search

Define your clinical question using PICO
IDENTIFYING SOURCES

‘Where’ to search
Sources Of Information

**ALL** relevant studies must be found by searching
Search strategy – Refined, documented (i.e. you must keep a record of all searches)
SEARCH SYNTAX

- Boolean logic
- Phrase searching
- Truncation/wildcards
- Parenthesis
Boolean Operators

**OR** -- either terms may be present
→ more results
  e.g. cancers OR neoplasms

**AND** both terms must be present
→ fewer results
  e.g. jet injection AND lidocaine

**NOT** → Use with caution*
e.g. Humans NOT animals
*Studies on both humans AND animals (intersection area) would be missed

**NOTE:** Boolean operators: AND, OR, NOT, must be entered in UPPERCASE in PubMed
More Search Syntax

PHRASE SEARCHING (using “ ”)
“J-Tip lidocaine”

TRUNCATION
Therap* → find therapy, therapies, therapeutic, therapeutics, etc.
(Note: PubMed used only the first 600 variations.)

WILDCARDS (example in MedLine (OVID))
an?esthesia → find anesthesia or anaesthesia
Organi#ation → find organization or organisation

BRACKETS/PARENTHESIS

jet AND ( lignocaine OR lidocaine )
SEARCH METHODOLOGY

Subject Headings (MeSH) vs. Keyword Search

Recap what you have learnt from PR3144
What is PubMed/MEDLINE?

PubMed

- PubMed comprises more than 29 million citations for biomedical literature from MEDLINE, life science journals, and online books.
- MEDLINE, largest component of PubMed (25 million records from 5600 journals)
- Search interface developed by the National Center for Biotechnology Information (NCBI) at National Library of Medicine (NLM)

MEDLINE

- Biomedical literature database covering the fields of medicine, dentistry, nursing and health care system
- Medline records are indexed using MeSH
- Updated daily – in press, ahead of print
- Coverage: US & 80 other countries

Free access at https://www.ncbi.nlm.nih.gov/pubmed
What is Medical Subject Headings (MeSH)

Using the NLM controlled vocabulary, Medical Subject Headings (MeSH), to index citations

Provides a consistent way to retrieve information
The MeSH Hierarchy

Entry Terms:
- Injection
- Injectable
- Injectable

Other ways to find Synonyms
- Thesaurus
- Subject terms in Library catalogue and
- Key concepts or Descriptors (Author supplied)
- Find a review article and look for the “keywords” used to search the different databases

The + sign indicates that there are more specific terms under the subject

Injections, Jet

Biolistics
What is Keyword

Example of list of possible keywords related to “jet administration of lidocaine”

<table>
<thead>
<tr>
<th>jet administration of lidocaine/lignocaine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords on ‘jet injection’</td>
</tr>
<tr>
<td>jet</td>
</tr>
<tr>
<td>J-tip</td>
</tr>
<tr>
<td>needle-free</td>
</tr>
<tr>
<td>“needle free”</td>
</tr>
<tr>
<td>“no needle”</td>
</tr>
<tr>
<td>needleless</td>
</tr>
<tr>
<td>needle-less</td>
</tr>
</tbody>
</table>
MeSH Versus Keywords

- Least precise
- Broadest
- Current (retrieve latest studies pending MeSH indexing)

- More precise
- Narrower
- Slightly dated (miss latest studies due to delay in indexing)

- Most precise
- Not recommended to use to build search for systematic review
Exercise 2: Plan Your Search

1. Identify relevant **MeSH terms** via MeSH database
2. Identify synonyms to build **keyword** search statement
1. About systematic review √

2. Preparing an EndNote Library for Systematic Review √

3. Defining A Focused Question √

4. Identifying Sources to Search √

5. Search Syntax √

6. Subject Heading vs. Keyword search √

7. Developing Search Strategy (with hands-on exercises)
   a. Pubmed
   b. The Cochrane Library
   c. Embase

8. Reporting the Search Process

9. Managing Search Results With EndNote
   ▪ Remove duplicates
   ▪ Export the Endnote Library to Excel
   ▪ Backup
DEVELOPING SEARCH STRATEGY

a. MEDLINE (via PubMed)
‘Intervention’ Terms - Construct The Search Strategy

1. To search MeSH terms for ‘I’ term (Jet Lignocaine)
2. To search the keywords for ‘I’ term
   a) Brainstorm for synonyms or related terms
   b) Combine similar concepts with ‘OR’ operators
   c) Search specifically in title/abstract ([tiab]) field

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>jet administration of lidocaine</td>
<td></td>
<td>jet</td>
</tr>
<tr>
<td></td>
<td></td>
<td>J-tip</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;no needle&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needleless&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-less&quot;</td>
</tr>
</tbody>
</table>
### ‘Intervention’ Terms - Construct The Search Strategy

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
</table>

**tiab** = search only in ‘title’ or ‘abstract’ filed of the database record
**Search Strategy For ‘Intervention’ — Jet Administration Of Lidocaine**

Combine **MeSH & Keywords** on similar concepts using ‘OR’
Combine different concepts (i.e. ‘jet’ AND ‘lidocaine’) using ‘AND’

<table>
<thead>
<tr>
<th>Intervention = Jet administration of Lidocaine</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search: 28/2/2019
### Search Strategy For ‘Population’
- Children who are fearful of needle-related pain

<table>
<thead>
<tr>
<th>Patient = Child/children/infant/paediatric with fear of pain (Combining MeSH and keyword)</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search 17/6/2019
Combining ‘Population’ & ‘Intervention’ Terms

<table>
<thead>
<tr>
<th>#</th>
<th>Query</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search in PubMed: 28/2/2019
# The Cochrane Randomised Controlled Trials Filters for PubMed & Embase

## PubMed

(ran* OR factor* OR cross NEAR/1 over* OR placebo* OR doubl* NEAR/1 blind* OR singl* NEAR/1 blind* OR assign* OR allocat* OR volunteer*):de,ab,ti

[link](http://work.cochrane.org/pubmed)

## Embase

'crossover procedure':de OR 'double-blind procedure':de OR 'randomized controlled trial':de OR 'single-blind procedure':de OR (ran* OR factor* OR cross NEAR/1 over* OR placebo* OR doubl* NEAR/1 blind* OR singl* NEAR/1 blind* OR assign* OR allocat* OR volunteer*):de,ab,ti

[link](http://work.cochrane.org/embase)
PubMed: Change The Results Display

Change from summary to abstract view

Format: Summary

<table>
<thead>
<tr>
<th>Format</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Summary</td>
<td></td>
</tr>
<tr>
<td>Summary (text)</td>
<td></td>
</tr>
<tr>
<td>Abstract</td>
<td>✔️</td>
</tr>
<tr>
<td>Abstract (text)</td>
<td></td>
</tr>
<tr>
<td>MEDLINE</td>
<td></td>
</tr>
<tr>
<td>XML</td>
<td></td>
</tr>
<tr>
<td>PMID List</td>
<td></td>
</tr>
</tbody>
</table>

Selected: Abstract

Search Details

Export From PubMed To EN: < 200 items

Search results

Items: 1 to 20 of 49

1. Randomized Clinical Trial of Lidocaine Analgesia for Catheterization Delivered via Blunt Tipped Applicator
   Uspal NG, Strellitz B, Grittton J, Follmer K, Bradford MW, Klein EJ.
   PMID: 29232351
   Similar articles

2. A Randomized Double Blind Trial of Needle-free Inj
   Anesthesia for Infant Lumbar Puncture.
IMPORTING INTO ENDNOTE

In Endote
Go to File>Import to import the text file which you have exported
Select ‘PubMed(NLM)’ as import option
Click Import (see below)
EN: Annotating Record With Name of Database (After Exporting Results)

Video on EndNote: Change and Move Fields [https://youtu.be/bE-L_SQg3Q]
EN: Organise Citations Using ‘Groups’

In Endnote, select the citations, then right-click

- Record Summary
- New Reference
- Edit References
- Move References to Trash
- Create Custom Group

Add References To
- Jet Lidocaine
- Cochrane
- Embase
- PubMed

Copy References To
- E-mail Reference
- Remove References From Group
- Cut
- Copy
- Copy Formatted
- Paste

Mark as Read
Mark as Unread
Rating

Show All References
Show Selected References
Hide Selected References

File Attachments
PDF Viewer
Find Full Text
Find Reference Updates
URL
Web of Science
Restore to Library
Resolve Sync Conflicts
How To Save Searches / Set Email Alerts

- Click ‘Sign in to NCBI’ on the top right corner of the PubMed Homepage
- Register for an NCBI account or login in via partner organization account (e.g. Google login)
How To Save Searches / Set Email Alerts

- Review search **History** and pick best search strategy to save
- Save searches & receive automatic e-mail alerts

Refer to video at https://youtu.be/WbFjV91YNNY
Exercise 3: Run Your Search

1. Construct search strategy using the appropriate Boolean operators to structure your search
   - #1 Patient(P) → combine MeSH & Keyword with ‘OR’
   - #2 Intervention(I) → combine MeSH & Keyword with ‘OR’
   - #1 ‘AND’ #2 → (combine P & I with ‘AND’) 

2. Search for RTCs in PubMed using Randomised Controlled Trials (RCT) filter recommended by Cochrane

3. Export citations to Endnote Library & annotate the ‘Name of Database’

4. Save your search strategy
DEVELOPING SEARCH STRATEGY

b. The Cochrane Library (Wiley)
http://www.cochranelibrary.com/
Searching The Cochrane Library at http://www.cochranelibrary.com/
Cochrane Search Interface

SEARCH FUNCTION

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>Who should use it, What does it do and What’s New</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 SEARCH</td>
<td>• For users interested in performing quick searches with a few terms</td>
</tr>
<tr>
<td></td>
<td>• For experienced users who prefer to use pull down menus to search fields</td>
</tr>
<tr>
<td></td>
<td>• Includes auto-suggest feature <strong>New</strong></td>
</tr>
<tr>
<td></td>
<td>• Supports up to five search rows</td>
</tr>
<tr>
<td>2 SEARCH MANAGER</td>
<td>• For searchers interested in <strong>creating complex strategies</strong></td>
</tr>
<tr>
<td></td>
<td>• Supports Boolean and proximity operators, nesting, and field searching</td>
</tr>
<tr>
<td></td>
<td>• Combine search line</td>
</tr>
<tr>
<td></td>
<td>• Insert a line, add one search to another and orphan line detection <strong>New</strong></td>
</tr>
<tr>
<td>3 MEDICAL TERMS (MESH)</td>
<td>• For users wanting comprehensive searching of medical concepts using MeSH</td>
</tr>
<tr>
<td></td>
<td>• Includes auto-suggest feature <strong>New</strong></td>
</tr>
<tr>
<td></td>
<td>• All MeSH information, permuted index, tree(s) and results, on one page</td>
</tr>
<tr>
<td></td>
<td>• Improved qualifier search and support for all thesaurus functions</td>
</tr>
<tr>
<td>4 BROWSE</td>
<td>• Browse Cochrane Reviews by:</td>
</tr>
<tr>
<td></td>
<td>Topic, new reviews, updated reviews, A – Z or Review group</td>
</tr>
<tr>
<td></td>
<td>• Browse all other Cochrane Library Databases</td>
</tr>
<tr>
<td></td>
<td>• Other Reviews, Trials, Methods Studies, HTA, Economic Evaluations</td>
</tr>
</tbody>
</table>
Searching MeSH Terms For ‘Intervention’

Follow step 1-6 to do a MeSH search for intervention ‘jet injection’
1. Enter the keywords directly into the search box #2 as shown
2. You can add the suffix: \texttt{ti,ab} to the end of the term
3. Enclose search terms with ( ) before appending: \texttt{ti,ab} if you are entering more than one word in a field search
Cochrane Search Strategy

4. Repeat **MeSH search and Keyword** search for ‘lidocaine’
5. Combining concepts on ‘jet injection’ (#3) and ‘lidocaine’ (#6) with ‘AND’ (see search results for ‘I’ in #7)
Cochrane Search Results

Scan the results and retrieve the relevant full text articles
Open your Endote Library
Double click the downloaded file ('citation-export.RIS') to import the citations into EndNote.
DEVELOPING SEARCH STRATEGY

c. Embase (Elsevier)
https://www.embase.com/login
Subject coverage
• Biomedical (in-depth coverage of pharmacology, pharmaceutical science and clinical research)
• Medical devices
• Life sciences & Allied Health

Content:
• >30% of Embase journal titles are unique (i.e., not covered by MEDLINE)
• >32 million published and peer-reviewed records, in-press publications
• Over 2.4 million conference abstracts indexed from more than 7,000 conferences from 2009
• Coverage of 8,500 indexed peer-reviewed journals from 1947

Strength:
• Deep full-text indexing with Emtree thesaurus (75,000+ terms), includes all MeSH terms, particularly strong in drug, disease and medical device terms
PICO Search

Click at ‘Search’ tab, select PICO

Type your search term at the ‘Find best term’ box
Searching for ‘Intervention’ (‘I’) term

1. In the ‘Find best term’ box, type the Intervention (I) term ‘jet injection’.
2. Corresponding synonyms will be auto-generated.
Searching for ‘Intervention’ (‘I’) term

3. Click at the ‘triangle’ sign.

4. Check the radio button next to the ‘Title or Abstract’ to focus the search of synonyms in title or abstract field.
Search For ‘Intervention’ Term

Searching for ‘Intervention’ (‘I’) term

5. Back to the ‘Find best term’ box, type the Intervention (I) term ‘lidocaine’ and select synonyms (search in title/abstract field).

6. Use ‘AND’ to combine search concept on ‘jet injection’ with ‘lidocaine’ and its synonyms.

7. The PICO Search form will automatically combine all the ‘Intervention’ terms to display the search results.
Export Embase Citations To EN

1. Set alert
2. RSS feed
3. Search details
4. Index miner

Select number of items
Selected: 25 (clean)
Show all abstracts

Results

Choose a format:
- RIS format (Mendeley, EndNote)

Content:
- A1: Author names
- AD: Correspondence address
- C1: Drug trade names
- C2: Drug manufacturers
- C3: Device trade names
- C4: Device manufacturers
- C5: Medline PMID
- DB: Name of Database
- DO: Digital Object Identifier (DOI)
- EP: End page
- ER: End of record
- IS: Issue
- IJ: Journal Title (full)
- IO: Journal Title
- KW: Keyword
- L2: DOI/full text link

Export as ‘RIS format’

Open Endote software & double click the ‘records.ris’ file to import the citations to EndNote.
Using EMTREE To Identify Subject Headings

Start search with Browse EMTREE, enter word or phrase without quote.

Click Find term.

As you type, EMTREE auto suggest subject headings for your selection.
EMTREE (Embase subject headings)

EMTREE automatically identifies drug, diseases or device terms & prompts to take query to appropriate search to add subheading, etc.

Hierarchy of Emtree terms, along with number of records
REPORTING THE SEARCH

a. The literature search process
b. PRISMA requirements
Reporting Your Literature Search

Methods section

• The names of the database searched (dates of coverage)
• The dates of the last search for each database
• PICO concepts that were searched for
• Limits applied (e.g., publication date, study design, language, etc.)
• Other sources searched (grey literature, handsearching, reference list)
• List individuals or organizations contacted
• Include the detailed search in an Appendix

Record the number of search results retrieved for each database and fill this total number in the PRISMA flow diagram (see next slide)
PRISMA Flow Diagram

- PRISMA (Preferred Reporting Items for Systematic Reviews and Meta-analyses)
- A transparent way of reporting your search results of systematic reviews and meta-analyses

Source: http://prisma-statement.org/prismastatement/flowdiagram.aspx
SUMMARY: DEVELOPING A SEARCH STRATEGY

- Searching is an iterative process
- Revise your search till you are satisfied with the results

Start here

1. Formulate the focus question
2. Select databases
3. Build the search strategy: MeSH term + Keywords
4. Refine the search: Study design (RCTs filter) limits
5. Analyse the results

- Use results: YES
- Satisfactory
- Use results: NO
Systematic Reviews: Critical Appraisal Tools

- The Centre The CASP Checklist [https://casp-uk.net/casp-tools-checklists/](https://casp-uk.net/casp-tools-checklists/)
- The Centre for Evidence-Based Medicine (CEBM) [https://www.cebm.net/2014/06/critical-appraisal/](https://www.cebm.net/2014/06/critical-appraisal/)
- Joanna Briggs Institute Critical Appraisal tools [https://joannabriggs.org/critical_appraisal_tools](https://joannabriggs.org/critical_appraisal_tools)
- The Cochrane Collaboration’s tool for assessing risk of bias (See Chapter 8: Assessing risk of bias in included studies) [https://training.cochrane.org/handbook](https://training.cochrane.org/handbook)
- The Newcastle-Ottawa Scale (NOS) for assessing the quality of nonrandomised studies in meta-analyses [http://www.ohri.ca/programs/clinical_epidemiology/oxford.asp](http://www.ohri.ca/programs/clinical_epidemiology/oxford.asp)

Refer to NUS Systematic Review Guides at [http://libguides.nus.edu.sg/sysreviews](http://libguides.nus.edu.sg/sysreviews)
ENDNOTE

- Remove duplicates
- Exporting EN references to MSExcel
- Backup

OPTIONAL

» Cite While You Write (CWYW) → see Endnote channel on Youtube
» Converting to Plain Text
Finding and Removing Duplicates

[Diagram showing the process of finding and removing duplicates in a reference management software.]

- Select the 'Find Duplicates' option from the main menu.
- Review the duplicate references and decide which ones to keep or move to the trash.
- Use the 'Skip' or 'Cancel' options to navigate through the duplicates.

Note: The example shows a screenshot from a reference management tool, demonstrating how to handle duplicate references efficiently.
Using ‘NUSLib_SysRev.ens’ 
(a customised EN Output Style) for export to EXCEL worksheet

On your computer, locate where the Endnote Programme folder is 
Look for a folder called ‘Styles’

<table>
<thead>
<tr>
<th>Name</th>
<th>Date Modified</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>NUSLib_SysRev.ens</td>
<td>25 Feb 2019 15:56</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>Tab_Delimited_Export_To_Excel.ens</td>
<td>23 Feb 2019 11:43</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>NUSL-TabD-Systematic Review.ens</td>
<td>22 Feb 2019 10:21</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>Turabian 9th Footnote.ens</td>
<td>4 Jun 2018 17:01</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>Chicago 17th Footnote.ens</td>
<td>4 Jun 2018 17:00</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>EndNote Export.ens</td>
<td>23 May 2018 18:20</td>
<td>EndNote Style</td>
</tr>
<tr>
<td>MLA 8th.ens</td>
<td>22 May 2018 15:03</td>
<td>EndNote Style</td>
</tr>
</tbody>
</table>

CO5210 MPH Practicum

- Searching in Context of Systematic Reviews
- Worksheet_PICO_searchstring
- Boolean Logic for Embase, Pubmed and Scopus: Basic
- Database Coverage Guide: Scope, coverage and content of selected databases useful for doing systematic reviews

NUH Research Residency Program

- Database Syntax Guide: PubMed, Cochrane, Embase.com, PsycInfo and CINAHL
- Embase PICO Search Guide from Elsevier
- Literature Searching Skills
- PICO worksheet (with RCT filter)
- Pubmed Handout: A quick reference guide
- NUS Libraries systematic review output style
Exporting EN citations to Excel (for analysis of results)
Steps To Bring .txt Into EXCEL

1. Open Excel and go to the "Data" tab.
2. Click on "From Text" under the "Get & Transform" section.
3. Select the .txt file you want to import.
4. In the "Text Import Wizard - Step 1 of 3" screen, choose "Delimited" as the file type.
5. In the "Text Import Wizard - Step 2 of 3" screen, select the appropriate delimiters (like Tab, Comma, Space) and set the text qualifier.
6. In the "Text Import Wizard - Step 3 of 3" screen, review the data preview and set the data format (like General, Date, Time).
7. Click "Next" to proceed and "Finish" to import the data into Excel.
### Example of Exported References Using ‘NUSLib_SysRev’ Output Style

<table>
<thead>
<tr>
<th>No.</th>
<th>Author</th>
<th>Year</th>
<th>Title</th>
<th>Journal</th>
<th>Volume</th>
<th>Issue</th>
<th>Name of databases</th>
<th>Abstract</th>
</tr>
</thead>
<tbody>
<tr>
<td>478</td>
<td>L. Berlin, G. Grange, N.</td>
<td>2014</td>
<td>Nicotine patches in pregnant women: BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>426</td>
<td>D. C. Berry, M. Nebi, E.</td>
<td>2013</td>
<td>Rationale, design, and methodology: BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>440</td>
<td>N. Blase, A. Nacci, A.</td>
<td>1997</td>
<td>Telemedicine in the treatment of Annual review oftelemedicine</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>448</td>
<td>L. Bracero, S. Mong</td>
<td>1999</td>
<td>Comparison of visual and comput American Journal of obstetrics</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>457</td>
<td>A. L. Briley, S. Barr, S.</td>
<td>2014</td>
<td>A complex intervention to improve BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>458</td>
<td>A. L. Briley, S. Barr, S.</td>
<td>2014</td>
<td>A complex intervention to improve BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>449</td>
<td>A. L. Calle-Pascual, N.</td>
<td>2010</td>
<td>The outcomes of gestational dia International journal of endocrinology</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>452</td>
<td>F. Carral, M. G. Ayala</td>
<td>2015</td>
<td>Web-Based Teleradiology System: Diabetes technology &amp; therapy</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>468</td>
<td>C. Chiswick, R. &amp; M. Rey</td>
<td>2015</td>
<td>Effect of metformin on maternal &amp; The Lancet Diabetes and Endocrinol</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>476</td>
<td>J. M. Dodd, I. Turlbut</td>
<td>2014</td>
<td>Antenatal lifestyle advice for women: BMJ (Clinical research ed.)</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>470</td>
<td>J. M. Dodd, I. Turlbut</td>
<td>2014</td>
<td>Antenatal lifestyle advice for women: BMJ (Online)</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>479</td>
<td>O. F. Dueñas-García, A.</td>
<td>2011</td>
<td>Prenatal outcomes of patients in Ginecología y obstrucción de M</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>480</td>
<td>A. Ferrara, M. M. Heda</td>
<td>2014</td>
<td>A pragmatic cluster randomized BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>481</td>
<td>A. Ferrara, M. M. Heda</td>
<td>2014</td>
<td>A pragmatic cluster randomized BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>485</td>
<td>J. K. Givens, D. Kane</td>
<td>2014</td>
<td>Tele-Mum: A feasibility study for BMJ (Diabetic medicine)</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>477</td>
<td>J. E. Harding, J. E. Hap</td>
<td>2015</td>
<td>Randomized trial of neonatal hypothyroidism: Pediatrics</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>478</td>
<td>E. Healy, P. Mittal</td>
<td>2013</td>
<td>The DIAMOND study: postpartum: BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>485</td>
<td>E. Healy, P. Mittal</td>
<td>2013</td>
<td>The DIAMOND study: postpartum: BMJ pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>462</td>
<td>C. J. Homko, L. C. Dees</td>
<td>2012</td>
<td>Impact of a telemedicine system: Diabetes technology &amp; therapy</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>463</td>
<td>C. J. Homko, L. C. Dees</td>
<td>2012</td>
<td>Impact of a telemedicine system: Diabetes technology &amp; therapy</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>467</td>
<td>A. L. Hui, S. Ludwig, P.</td>
<td>2010</td>
<td>Exercise and dietary intervention during pregnancy and childbirth</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>465</td>
<td>J. J. Infante, A. O’Dea</td>
<td>2013</td>
<td>Barriers to participation in a community Diabetes</td>
<td>13</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Manually insert a header line
Backup Your EN Library

1. Save the complete Library to a single compressed file (.enlx), including .DATA folder.
2. To backup: **File > Compressed Library**
3. To decompress: **double click file**
4. ‘Make Stuff Safe’: Save a copy to a secure storage
5. Avoid Cloud storage e.g. DropBox & Google Drive
APPENDIX 1: VIDEOS
HOW TO EXPORT SEARCH RESULTS FROM DATABASES INTO ENDNOTE

PubMed
https://youtu.be/Bndii3dQ1kw

Embase
https://youtu.be/VcJpb0YztkA

Scopus
https://youtu.be/alwH-ENkHIQ

Cochrane
https://youtu.be/QHXWaAZZBqE

CINAHL
https://youtu.be/KWc-G_FlkFQ

PsycINFO
https://youtu.be/4qEh0HsBQGs

Library Subject Guide
http://libguides.nus.edu.sg/c.php?g=145503&p=953994
APPENDIX 2: Endnote’s CWYW functions

Youtube: Endnote channel  
https://youtu.be/AAuGdJvIzTL

NUS Libraries Online Guide  
http://libguides.nus.edu.sg/Endnote
A copy of the Word document will be created with no field coding. Use before sending document to a publisher or submit to IVLE, as the field coding may interfere with other software, e.g. layout applications used by publishers.
Appendix 3: Exporting Large Number Of Results From Ebscohost Database
Please give us your feedback @

Thank You!

Medical Library
Walk in: Level 5, MD6
Telephone : 65162046
Email: mdlib@nus.edu.sg
URL: www.lib.nus.edu.sg